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HIGH TECC
 STYLE GUIDE

 A note on the content

The rules, standards, and recommendations in this guide originate from several reliable sources: 
the Chicago Manual of Style, the Microsoft Manual of Style, the Canadian Press Caps and Spelling Guide, 
and the Canadian Oxford Dictionary. General writing guidelines in the Tone, Voice, and Structure Princi‐
ples section of this guide are taken from The Insider’s Guide to Technical Writing, by Krista Van Laan. Refer 
to these sources for more information.

The standard English both used in, and promoted by, this guide is Canadian English, except where excep‐
tions are noted (e.g. proper nouns, company names).
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Chapter 1:  Tone, voice, and structure

1.1  Consistency and standards

1.1.1 Parallelism

Use elements in sentences that are grammatically similar or identical in structure. Every item in a list (bul‐

leted or not e.g. steps) should begin with the same part of speech and have a similar format. If the first 

item uses a gerund (“‐ing” word), every item that follows should also. If the first item is a question, the 

rest should be too.

1.1.2 Consistent term use

Use the same term everywhere (e.g. product name or computer component). Be clear on what terms 

mean and the best term to use for your audience, then use it consistently throughout the document.

1.1.3 Clarity

Eliminate unnecessary words. “Click the Add button in order to create a new user account” can be written 

as “click Add to create a new user.” The fewer words, the easier your content will be to read and the less 

ambiguous your meaning will be. Avoid slang, sarcasm, and humour. Avoid using words for anything other 

than their literal meaning. Avoid use of contractions such as it’s.

1.1.4 Word and sentence length

Use short words and sentences. The average American adult reads at between an eighth‐ and ninth‐grade 

level. Use small, even single‐sentence paragraphs. Follow these rules:

• Short words rather than long ones

• Paragraphs no longer than six lines

• Sentences no longer than 25 words

• Paragraphs no longer than six lines (not sentences)

If you can’t get the paragraph’s idea across in six or fewer lines, you may have too many words, or you 

may be trying to include two ideas in one paragraph.
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1.1.5 Basics

HIGH TECC writers should be aware of these characteristics of good documentation: 

•  Correct

•  Complete

•  Usable 

•  Clear 

•  Consistent

Other important considerations include design and layout, and context‐sensitivity and searchability.

1.1.6 Usability

To assess your content’s usability, ensure the following criteria are met: 

• Users can find information they need quickly

• Instructions are clear and easy to follow

• Users can find their place again quickly

• Instructions accurately describe how to complete the tasks they claim to

1.1.7 Scannable content

Many readers scan documents to determine if the rest is worth reading. Users find white space inviting. 

Including some of the following facilitates more whitespace and allows for easy scanning.

• Headings and subheadings: Keep short and use keywords

• Keep documents and web pages short 

• TOCs: Use for long webpages or documents, include links to headings

• Use bulleted lists, which are easier to scan and read than paragraphs

1.2  Procedural guidelines

1.2.1 Negatives

Only use negatives to express things the user should not do, as in warnings or cautions.

1.2.2 Tense

Use present tense. Avoid past tense. Only use future tense when you are writing about something that 

will happen in the future, e.g. the backup will take place after you submit the changes. Use “a page 

appears” instead of “a page will appear”. 
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1.2.3 Second person

Speaking directly to the reader helps clarify information and language. If you must, use limited use of you. 

Second person has a number of benefits.

• Uses fewer words than third person, document is shorter

• Easy to avoid passive voice

• Instructions are easier to write when you directly state steps in a process

• Avoids issue of gender‐neutrality (don’t have to worry if reader is a he or a she)

• Addresses reader in a conversational manner, easy to follow

1.2.4 Voice

 Use active voice and imperative mood. Avoid passive voice, with a few exceptions. Use the passive voice 

when the subject is: Unknown (although the subject should be truly unknown, not simply because you 

don’t happen to know it) Unimportant Less important than the receiver of the action For example, “The 

content is backed up continually” is an example of a passive voice sentence that makes sense. The content 

is the important focus here. It wouldn’t even make sense to say that a combination of software programs, 

operations people, scheduling commands, and machines all work together to back up the content.

1.2.5 Non-standard terms 

Acceptable non‐standard terms include company names and tech‐relate terms. See the usage list in chap‐

ter 5 for more examples, or consult the approved style and spelling resources noted in the forward of this 

guide. 

In informal content (blog or social media posts) if the tone is conversational, the following list of addi‐

tional non‐standard terms may be used sparingly. 

Alright, BRB, cool, damn (for very), emoji, funner, funnest, gif, gifting, gotta, tweet, stupidest, yeah.

Contraption (instead of device), quote (instead of quotation), in regards to (vs. in regard).

In formal or informal contexts, utilize (instead of use) and in regards to (instead of in regard) is also 

acceptable.

1.2.6 Spaces between sentences, paragraphs, and sections

Leave a single character space, not two spaces, between sentences and after colons used within a sen‐

tence. An electronic document should never have more than one character space between sections (or 

no more than one ‘hard return’ e.g. hitting enter). Spaces between lines, headings, and paragraphs should 

all be set using the documentation tool’s style or tag settings. Avoid extra space or blank lines between 

paragraphs 

Be sure to eliminate any extra character space or tab after the final punctuation at the end of a para‐

graph; the hard return should follow the punctuation immediately.
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Chapter 2: Spelling, grammar, and punctuation

2.1  Grammar

2.1.1 Verbs and nouns

Avoid noun and verb phrases e.g. put up with vs. tolerate, make sure vs. ensure. Avoid participle forms of 

verbs and nouns formed from verbs vs. simple verb tenses.

2.1.2 Personal pronouns

Avoid use of personal pronouns, such as he/she, use gender neutral options instead (e.g. they).

2.2  Punctuation

2.2.1 Semi-colon

A semicolon is most commonly used between two independent clauses not joined by a conjunction to sig‐

nal a closer connection between them than a period would. When a semicolon is used to join two or 

more ideas (parts) in a sentence, those ideas are then given equal position or rank. They may also be used 

with conjunctions, and between items in a list or series if any of the items contain commas.

2.2.2 Colon

When a colon is used within a sentence, the first word following the colon is lowercased unless it is a 

proper noun. When a colon introduces two or more sentences or when it introduces speech in dialogue 

or a quotation or question, the first word following it is capitalized.

A colon introduces an element or a series of elements illustrating or amplifying what has preceded the 

colon. Between independent clauses it functions much like a semicolon, Use a colon sparingly and only to 

emphasize that the second clause illustrates or amplifies the first. (The colon usually conveys or reinforces 

the sense of “as follows”). The colon may sometimes be used instead of a period to introduce a series of 

related sentences.

2.2.3 Comma

Use serial commas. The comma, aside from its technical uses in scientific, bibliographical, and other con‐

texts, indicates the smallest break in sentence structure. It usually denotes a slight pause. In formal prose, 

however, logical considerations come first. Effective use of the comma involves good judgment, with the 

goal being ease of reading. For additional information and examples, see the Chicago Manual of Style.

 1. Use commas to separate independent clauses when they are joined by any of these 
seven coordinating conjunctions: and, but, for, or, nor, so, yet.

2. Use commas after introductory a) clauses, b) phrases, or c) words that come before the 
main clause.
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3. Use a pair of commas in the middle of a sentence to set off clauses, phrases, and words 
that are not essential to the meaning of the sentence. Use one comma before to indi‐
cate the beginning of the pause and one at the end to indicate the end of the pause.

4. Do not use commas to set off essential elements of the sentence, such as clauses 
beginning with that (relative clauses). That clauses after nouns are always essential. 
That clauses following a verb expressing mental action are always essential5. Use com‐
mas to separate three or more words, phrases, or clauses written in a series.

5. Use commas to separate two or more coordinate adjectives that describe the same 
noun. Be sure never to add an extra comma between the final adjective and the noun 
itself or to use commas with non‐coordinate adjectives.

6. Use a comma near the end of a sentence to separate contrasted coordinate elements 
or to indicate a distinct pause or shift.

 7. Use commas to set off phrases at the end of the sentence that refer back to the begin‐
ning or middle of the sentence. Such phrases are free modifiers that can be placed any‐
where in the sentence without causing confusion.

 8. Use commas to set off all geographical names, items in dates (except the month and 
day), addresses (except the street number and name), and titles in names.

9. Use a comma to shift between the main discourse and a quotation.

10. Use commas to prevent possible confusion or misreading.em‐  dash.

2.2.4 Em-dash

Em dashes are used to set off an amplifying or explanatory element and can function as an alternative to 

parentheses, commas, or a colon—especially when an abrupt break in thought is called for. To avoid con‐

fusion, the em dash should never be used within or immediately following another element set off by an 

em dash (or pair of em dashes). Use parentheses or commas instead.

An em dash may be used before expressions such as that is or namely. They are best preceded by an em 

dash or a semicolon rather than a comma, or the entire phrase they introduce may be enclosed in paren‐

theses or em dashes.

A question mark or an exclamation point—but never a comma, a colon, or a semicolon—may precede an 

em dash. A period may precede an em dash if it is part of an abbreviation.

2.2.5 En-dash

The en dash connects numbers and, less often, words. With continuing numbers—such as dates, times, 

and page numbers—it signifies up to and including (or through). For the sake of parallel construction, the 

word to or through (or until), never the en dash, should be used if the word from precedes the first ele‐

ment in such a pair; similarly, and should be used if between precedes the first element. Also use an en‐

dash to hyphenate two already hyphenated terms or joining an open compound.
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2.2.6 Parentheses 

Parentheses—stronger than a comma and similar to the dash—set off material from the surrounding text. 

Like dashes but unlike commas, parentheses can set off text that has no grammatical relationship to the 

rest of the sentence. If the sentence requires a comma without the parentheses, include a comma after 

the closing parenthesis. if the sentence would not require a comma, do not include one.

2.2.7 Hyphenation

Use sparse hyphenation. Hyphens should be added only if doing so will prevent a misreading or otherwise 

significantly aid comprehension. Consult the Chicago Manual of Style and Canadian Oxford Dictionary for 

specific examples. 

2.3  Numbers 

Spell out numbers one through nine and use digits for numbers greater than nine. 

One but 10, except referring to page numbers, e.g. see page 3. 

2.3.1 Time and date

Though a.m. and p.m. sometimes appear in small capitals (with or without periods), Chicago prefers the 

lowercase form, with periods, as being the most immediately intelligible. See below for the ideal date for‐

mat. Note the lack of th following the day number.

10:00 a.m.

November 16, 2017

2.3.2 Year 

’83 for 1983

90s not 90’s

the 1940s and 1950s (or, less formally, the 1940s and ’50s, or the forties and fifties)

Use directional (or “smart”) apostrophes. In most typefaces, this mark will appear as a raised (but not 

inverted) comma.

We spent the ’90s (not ‘90s) in thrall to our gadgets.



Chapter 2: Spelling, grammar, and punctuation

For Internal Use Only| HIGH TECC Editorial Style Guide© 2017 HIGH TECC Editorial Style Guide  8  

2.3.3 Measurements

Use metric system measurements (e.g. metre, gram, litre). 

A space is normally used between the numeral and the unit of measure, except in a few cases—for exam‐

ple, with degree, percent, and prime symbols.

50 km (kilometres); a 50 km race

21 ha (hectares)

4.5 L (litres)

85 g (grams)

240 V (volts)

10°C, 10.5°C

3′6″

A unit of measurement used without a numeral should always be spelled out, even in scientific contexts. 

We took the measurements in kilojoules (not kJ).

2.3.4 Larger numbers

Commas are used between groups of three digits for numerals of one thousand or more, but spell out

 larger numbers.

33,333.33.

She signed a ten‐year, $250 million contract.

2.3.5 Currency

Indicate international currency references if necessary. 

Three hundred Canadian dollars = C$300 or Can$300

$749 in New Zealand dollars = NZ$749

Isolated references to amounts of money are spelled out for whole numbers of one hundred or less.

seventy‐five cents = 75¢

fifteen dollars = $15
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Whole amounts expressed numerically should include zeros and a decimal point only when they appear 

in the same context with fractional amounts. Note the singular verb in the second example.

Children can ride for seventy‐five cents.

The eighty‐three dollars was quickly spent.

The instructor charged €125 per lesson.

Prices ranged from $0.95 up to $10.00.

2.3.6 Simple fractions

Simple fractions are spelled out. For the sake of readability and consistency, they are hyphenated in noun, 

adjective, and adverb forms. In the rare event that individual parts of a quantity are emphasized, the 

expression is unhyphenated.

one‐third

2.3.7 Percentages

Express percentages in numerals, e.g. 50%. 

2.3.8 Page numbers

Include page numbers at the bottom right of each page, unless the project dictates centre alignment. To 

ensure that no two pages in the manuscript are numbered the same, add descriptive page headers next 

to the page numbers in each file (e.g., “Introduction: 1,” “Introduction: 2,” etc.). Roman numerals may be 

used for the front matter.

2.4  Canadian spelling

Refer to the Canadian Press Caps and Spelling guide for more information. 

Canadian spelling differences

-our (vs. -or) -re (vs. er) -c- and -s-

arbour flavour rumour centre defence
ardour harbour saviour fibre licence (n.)
armour honour savour litre license (v.)

behaviour humour splendour lustre offence 
candour labour succour manoeuvre practice (n.)
colour neighbour tumour metre practise (v.)

demeanour odour  valour mitre pretense 
endeavour parlour vapour ochre

favour rancour sceptre
fervour rigour sombre
arbour flavour theatre
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-yze (vs. -yse) foreign plurals silent e + suffix -l or -ll dipthongs 

analyze appendices abridgement appall anemia
breathalyzer bureaus acknowledgement distill Anesthesia 

catalyze châteaux aging enrol diarrhea
dialyze indices judgment enrolment estrogen

paralyze referendums likeable forestalment etiology
livable fulfill hemorrhage

saleable fulfillment manoeuvre
sizable instalment oenology

instill orthopedic
pediatric

compounds compounds + 
prefixes and 

suffixes 

2x consonants other spelling differences

back-stabber anti-social combatting airplane mould
catch-all co-author equalled artifact moustache 

court martial co-operate gravelled axe peddlar 
daycare faceoff imperilled balk plow
 facelift multi-ethnic libellous catalogue program 

homemade post-graduate marshalled cheque pyjamas
mind-reader post-mortem marvellous cozy raquet  
second-hand pre-empt pedalled draft skepticism 

year-long pre-set signaller dryly smoulder 
put-on traveller grey storey 
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Chapter 3: Capitalization, abbreviations, headings

3.1 General

3.1.1 Proper adjectives

A proper adjective is or is derived from a proper name. They begin with a capital letter.

New York minute

a Cuban cigar

a Canadian dollar).

3.1.2 Proper nouns

 A proper noun is always capitalized, regardless of how it is used. A proper noun is the name of a specific 

person, place, or thing, or the title of a work.

John Doe

Moscow

the Hope Diamond

Citizen Kane

 Proper nouns may be singular or plural (the Great Lakes, the Twin Cities).

3.1.3 Brand names with initial lowercase letter

Brand names or trademarks spelled with a lowercase initial letter followed by a capital letter need not be 

capitalized at the beginning of a sentence or heading. Names that begin with a capital letter and include 

additional capitals in the middle of the word should be left unchanged. In text that is set in all capitals, 

such distinctions are usually overridden (e.g., POWERPOINT); with a mix of capitals and small capitals, 

they are preserved (e.g. iPhone).

3.1.4 Titles of works

Titles mentioned or cited in text or notes are usually capitalized headline‐style.

3.1.5 Institutions and companies

The full names of institutions, groups, and companies (and the names of their departments), and the 

shortened forms of such names (e.g. the Art Institute), are capitalized. A the preceding a name, even 

when part of the official title, is lowercased. Generic terms like company and university are lowercased 

when used alone.

the University of Chicago; the university
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3.1.6 Professional and civil titles 

Civil, military, religious, professional, and academic titles are capitalized when they immediately precede 

a personal name and are used as part of the name. Titles are lowercased when following a name or used 

in place of a name.

Abraham Lincoln, president of the United States (or President Abraham Lincoln of the United States); 

President Lincoln; the president

General Bradley; the general

Although a full name may be used with a capitalized title (e.g., President Abraham Lincoln) avoid using the 

title before a full name, especially with civil, corporate, and academic titles. A title used alone, in place of 

a personal name, is only capitalized only in formal introductions, or when used in direct address.

Ladies and Gentlemen, the Prime Minister.

Thank you, Mr. President.

3.1.7 Keys, menu items, and file formats

All alphabet keys and named keys are capitalized even if they are lowercased on a particular keyboard. 

Named menu items and labels for toolbars, tabs, buttons, icons, etc. are spelled and capitalized as in a 

particular application or operating system or on a particular device. Abbreviations for file formats are ren‐

dered in full capitals unless expressed as extensions. Items or actions that are not specifically labeled can 

usually be treated generically.

The function key F2 has no connection with the keys F and 2.

The Option key on a Mac is similar to the Alt key on a typical PC.

3.1.8 Preference for lowercase 

Proper nouns are usually capitalized, as are some of the terms derived from or associated with proper 

nouns. HIGH TECC prefers sparing use of capitals, referred to as a “down style.”

3.2 Abbreviations and acronyms

A shortened form of a word or phrase. Avoid abbreviations and acronyms that include other abbrevia‐

tions or acronyms, e.g. LDIF for LDAP directory interchange format.

3.2.1 Abbreviations

Space is usually left between abbreviated words, unless an abbreviated word is used in combination with 

a single‐letter abbreviation. 

RN, C‐SPAN, YMCA, Gov. Gen.
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1. All‐capital abbreviations are written without periods (YMCA, AFL‐CIO, CN, MP, URL, 
RIP,) unless the abbreviation is geographical (U.S., B.C., P.E.I., T.O., U.K.) refers to a per‐
son (J.R. Ewing) or is a single letter (N. for north but NNW).

2. Most lowercase and mixed abbreviations take periods: f.o.b., Jr., Ont., No., B.Comm.

3. Mixed abbreviations that begin and end with a capital letter do not take periods: PhD, 
PoW, U of T.

4. Acronyms — abbreviations pronounced as words — formed from only the first letter of 
each principal word are all capitals: AIDS (acquired immune deficiency syndrome), 
NATO (North Atlantic Treaty Organization), NOW (National Organization for Women).

5. In most cases, acronyms formed from initial and other letters are upper and lowercase: 
Dofasco (Dominion Foundries and Steel Corp.), Nabisco (National Biscuit Co.), Norad 
(North American Aerospace Defence Command). Some exceptions have crept into 
common use (BMO, for Bank of Montreal); check individual listings.

6. Acronyms that have become common words are not capitalized: laser (light amplifica‐
tion by stimulated emission of radiation), radar (radio detection and ranging).

7. Metric symbols are not abbreviations and do not take periods: m, l, kW.

8. Plurals are MPs and PoWs; possessives MPs’ and PoWs’.

9. Most abbreviations are written without spaces: U.K., W.Va., P.Eng. But those written 
without periods are spaced: U of T.10. Ampersands are allowed if used as part of a cor‐
porate name: A&W, Standard & Poor’s, and in expressions like R&B. Usually, these are 
written without spaces when all‐capital abbreviations are used and with spaces when 
they are not. Check individual listings.

3.2.2 Acronyms and initialisms

Acronyms: Terms based on the initial letters of their various components and read as single words (AIDS, 

laser, NASA, scuba).

Initialism: Terms read as a series of letters (IRS, NBA, XML).

For both, no space is left between the letters, whether lowercase or in capitals. Organizations are com‐

monly represented by either acronyms or initialisms. Use all caps and no periods. Spell the full name out 

for most upon first use (or include the full spelling after the short form in parentheses). This is not neces‐

sary, however, for common acronyms which should be understood e.g. NASA.

3.2.3 Academic degree titles

Chicago recommends omitting periods in abbreviations of academic degrees (BA, DDS, etc.). Spelled‐out 

terms, often capitalized in institutional settings (and on business cards), should be lowercased. e.g. MA, 

master of arts degree.
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3.2.4 Common abbreviations 

The table below shows acronyms, intialisms, and abbreviations that appear frequently in HIGH TECC’s 

content. Many terms do not appear in this table. Exclusion of a term does not mean it is not acceptable. If 

the term you are looking for is not listed in the table, check the Canadian Press Caps and Spelling Guide 

and the Oxford Canadian Dictionary

Abbreviation

Terminology Full term

AC Alternating current

ACL Access control list

ANSI American national standards institute

API Application programming interface

ASCII American standard code for information interchange

AVI Audio video interleaved

B/C Because

B2b and B2c Business-to-business or -consumer

BIOS Basic input/output system

CSS Cascading style sheets

DBMS Database management system

DIY Do it yourself

EOBD End of business day

FAQ Frequently asked questions

HD High-definition

HTML Hypertext markup language

IP Internet protocol

LAN Local area network

NAFTA North American Free Trade Agreement

NASA  National Aeronautics and Space Administration
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3.2.5 Headings and titles 

Use sentence style capitalization for headings and titles. Some cases may call for all caps for impact.

For procedure titles/topic headings, use a gerund (-ing form) rather than infinitive (to form). Avoid start‐

ing headings with ‘using’ or ‘working with’.

Resizing an Image in Microsoft Word

Abbreviations

Terminology Full term

PnP Plug and Play

POV Point of view

RAM Random access memory

POP Point of presence

RGB Red-green-blue

SAA Systems application architecture

SAP Service advertising protocol 

SMTP Simple mail transfer protocol

SQL Server Structured Query Language

SSD Solid-state drive

TBA/TBD To be announced / determined

TCP/IP Transmission control protocol/Internet protocol

UI User interface

UNC Universal naming convention

URL Uniform resource locator

USB Universal serial bus

VBA Microsoft visual basic for applications

VLAN Virtual local area network

W3C World wide web consortium

WAN Wide area network

WEP Wired equivalent privacy

Wi-Fi Wireless networking technology

WPA Wi-Fi protected access
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For procedure headings, once the context has been established, introduce the procedure with an infini‐

tive phrase. 

To resize an image

Resize an image

With the exception of procedure headings and style guides, headings should have text between them and 

the next heading. This should be info that helps the user determine if they should read on. Describe a user 

problem that the content will help solve. 

3.2.6 Sentence style capitalization

Only the first word in a title or a subtitle and any proper names, nouns, etc. are capitalized. Some excep‐

tions may apply. 

3.2.7 Subtitles

A subtitle always begins with a capital letter. Although on a title page or in a chapter heading a subtitle is 

often distinguished from a title by a different typeface, when referred to it is separated from the title by a 

colon. When an em dash rather than a colon is used, what follows the em dash is not normally considered 

to be a subtitle, and the first word is not necessarily capitalized. A colon is used to separate the main title 

from the subtitle (even if no colon appears in the source itself). A space follows the colon.
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Chapter 4: Visual elements 

4.1 Lists 

Items in a list should consist of parallel elements. Omit introductory numerals or letters that don’t serve a 

purpose. Purposes include: to indicate the order in which tasks should be done, to suggest chronology or 

relative importance among the items, to facilitate text references, or, in a run‐in list, to clearly separate 

the items. 

If the introductory material forms a grammatically complete sentence, a colon should precede the first 

parenthesis. The items are separated by commas unless any of the items requires internal commas, in 

which case all the items will usually need to be separated by semicolons.

Aim to use vertical lists. A vertical list is best introduced by a grammatically complete sentence, followed 

by a colon. To avoid long, skinny lists, two columns can be used.

Where items in a numbered list are subdivided (i.e., into a multilevel list, also called an outline), use sec‐

ond level bullets.

• Spelling

•Using a dictionary appropriately

•Recognizing homonyms

4.1.1 Bullets

Use bulleted lists for items and options. Capitalize the first word of each entry. Do not include end stop 

punctuation for incomplete sentence points. Use punctuation at the end of points that are sentences. 

Avoid bullets that are more than one line or sentence. 

4.1.2 Numbered lists

Numbered lists are used in procedures or to describe a series of steps. Capitalize the first word of each list 

item.

4.2 Tables 

4.2.1 Numbering illustrations and tables

Numbering tables and illustrations is optional. HIGH TECC typically uses captions for illustrations (without 

numbering), and titles in table headings (without captions). If numbered, double numeration may be used 

(e.g., table 1.1, 1.2, 1.3, etc.). Double numeration can simplify the task of renumbering in the event a 

visual element is dropped or added.
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4.2.2 Table headings

Table headings should be as succinct as possible and not suggest any interpretation of the data. Titles 

should be in noun form, and participles are preferred to relative clauses: for example, “Households sub‐

scribing to à la carte channels,” not “Households that subscribe to à la carte channels.”

4.2.3 Captions (for illustrations and pictures)

A caption—the explanatory material that appears outside (usually below) an illustration—is distinct from 

a key and from a label, which appear within an illustration. Numbering in image captions is optional. Clos‐

ing punctuation after a caption is typically excluded. If one or more full sentences follow it, use closing 

punctuation. Use sentence style capitalization. See example below.

Northern Lights at Jokulsarlon glacier lagoon, Iceland

4.2.4 Chart titles and captions

The title of a chart appears as part of the caption, immediately following the figure number, and is capital‐

ized sentence‐style. Labels, the descriptive items within a chart, are normally lowercased (with the excep‐

tion of proper nouns or other terms that would be capitalized in running text); if phrases, they may be 

capitalized sentence‐style. Labels may be explained or discussed in a caption as needed.
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Example of a chart with caption

4.2.5 HIGH TECC logo HTML colour codes

HIGH TECC logo

Background colour = 36D6A6, Dark grey text = 4D6861, Light grey text = DBFDF2. Use these (or similar 

colours) whenever possible for text, headings, and tables.

4.2.6 Screen caps and Callouts

Screen captures must be crisp and clear. Use HIGH TECC’s screen capture software (SnagIt). Do not use 

low resolution images, which are distorted and fuzzy. Make sure all information is clear. 
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Use callouts created in SnagIt if possible. Use clean fonts at a minimum size of 9 points.

• Capitalize callouts

• Only end with a period if it is a complete sentence

Callouts add value to a screen shot by providing specific information that can help users instead of just 

showing them what they already can see for themselves. There is no need to show areas that are not rel‐

evant, unless they are required for giving the user context. A useful screen shot shows the user what to 

enter into a field, or which button or other on‐screen object is being discussed. Use callouts, or captions 

with pointers, to draw the user in. For more detailed information on callouts, see HIGH TECC’s Visual Style 

Guide.
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Chapter 5: Terminology and usage

5.1 Capitalization of internet terms
Capitalize specific proper names.

World Wide Web, but the web
Adobe Acrobat, JavaScript
Twitter, tweet

Lowercase descriptive or generic terms:

internet, electronic mail, email, blog, chat room, cyberspace, domain name, home page, hyperlink, 
instant messaging, shareware, web, web browser, webcam, webcast, web‐enabled, webmaster, web 
page, web server, website

Use all caps for well‐known acronyms and abbreviations.

CD‐ROM, FTP, HTML, HTTP (but lowercase in web addresses), PDF, RAM, URL

If providing an internet address, follow upper and lowercase of actual address. Include www if 
appropriate: www.thecanadianpress.com. If a company uses a variation of its internet address as its 
corporate name, capitalize the first word: Amazon.com.

5.1.1 Common usage and terminology

Below is a list of commonly used terms, what they mean, and how to use them (or what HIGH TECC rec‐

ommends using instead). 

A
add

In general, do not use add to refer to installing software. Use install instead.

antivirus

Use as an adjective, not as a noun. Do not hyphenate. 

affect, effect 

As nouns and verbs, affect and effect are often confused. Part of the problem is that the verb affect can be 

defined as “to have an effect on.” The verb effect means “to bring about.” As a noun, effect means 

“result.” The noun affect is a term in psychology and should not be used in content about software.

among, between
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Use among when referring to three or more persons or things or when the number is unspecified. Use 
between when referring to two persons or things or when referring to relationships between two items 
at a time, regardless of the total number of items.

Move between the two programs at the top of the list.
You can share folders and printers among members of your workgroup.

app

App is an acceptable abbreviation for application.

appears, displays

Displays requires a direct object; appears does not. Appears means to become visible or noticeable, with‐

out visible agent or apparent cause. If necessary in context, you can use the passive, is displayed.

If you try to exit the program without saving the file, a message appears.

Windows displays a message if you do not log on correctly.

A message is displayed if you do not log on correctly.

appendix, appendices

Use appendices as the plural form of appendix.

application

For a general audience, use program instead of application. Use application in content for a technical 

audience, especially to refer to a grouping of software that includes both executable files and other com‐

ponents.

B
because, as well as 

Use because and avoid as well as. It can be used both as a synonym for and as a prepositional phrase, 
making it ambiguous for machine translation. 

at sign (@)

Use only in internet email addresses. @ separates the user name from the domain name.

back up, backup

Two words as a verb, one word as an adjective or as a noun.
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backspace

Use as a verb.

because, since

Do not use since to mean because. This can be confusing to the worldwide audience, and the possible 
ambiguity may lead to mistranslation in machine‐translated content. In general, use because to refer to a 
reason and since to refer to a passage of time. If it is possible to misinterpret the meaning of since as 
referring to a reason, rewrite the sentence. 

browse, find

Use browse to mean a user manually looking for something in a folder or tree structure, or on a website. 
Use find to mean a user instructing the computer to search for something, such as a specific file, object, 
computer, website, server, term, or phrase.

C 
call out, callout

Two words as a verb, one word as an adjective or as a noun.

You should call out special features in the interface. 
Add callouts to the art. 
The callout wording should be brief.

caution

Advises users that failure to take or avoid a specified action could result in loss of data. Precede a caution 
with a warning symbol.

chapter

Use only in reference to content that is written as a book (in print or online). For online content, use 
section, topic, site, or another appropriate term.

check mark

Write as two words.



Chapter 5: Terminology and usage

For Internal Use Only| HIGH TECC Editorial Style Guide© 2017 HIGH TECC Editorial Style Guide  24  

clear

Use clear as a verb to describe the act of removing a check mark from a check box or removing a tab stop. 
Do not use turn off, unmark, uncheck, or deselect. The antonym of clear is select.

choose

Use choose when the user must make a decision, as opposed to selecting (not picking) an item from a list 
to carry out a decision already made.

click

In general, use click instead of select to refer to the user action of issuing a command or setting an 
option. For exceptions, see select. Do not use click on or click at. However, you can say “click in the 
window.” With this exception, click should always be a transitive verb. 

It is okay to omit “Click OK” at the end of a procedure if it is clear that the user must click OK to complete 
the procedure.

cancel the selection

Use instead of deselect or unmark. Use clear to refer to check boxes.

comprise

Do not use unless you have no other choice. Comprise has a history of misuse and is misunderstood even 
by many native English speakers. It means “to include” or “to (metaphorically) embrace.” The whole 
comprises or is composed of its parts; the parts compose or are comprised in the whole. Comprised of is 
always incorrect. The forms of compose are generally better understood than those of comprise, but 
synonyms, such as include and contain, are clearer to most users.

context-sensitive

Always hyphenate.

D
default

Do not use default as a verb unless you have no other choice. It is jargon. Fine to use it as a noun or as an 
adjective.

If you do not select a template, Word uses Normal.dot by default.
This value specifies the number of sheets to add. The default is one sheet.

delete
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As a verb, use delete to refer to actions that the Delete command takes, such as moving files to the 
Recycle Bin and moving items in Microsoft Outlook to the Deleted Items folder. You can use delete to 
describe these actions even if the user arrives at them by some other way, such as by dragging a file to 
the Recycle Bin.

Use delete to refer to actions that result from pressing the Delete or Backspace key on the computer, 
such as deleting selected text. Do not use delete as a synonym for remove. Do not use cut or erase as a 
synonym for delete. 

Delete MyFile.txt from the Windows folder.
Remove the Size column from the Inbox.

deselect

Do not use. In general, use cancel the selection. For check boxes, use clear.

discreet vs. discrete

Be sure to use these words correctly. Discreet means “showing good judgment” or “modest.” Discrete 
means “separate” or “distinct” and is more likely to appear in technical content.

display

Use as a noun to refer generically to the visual output device and its technology, such as a flat‐panel 
display. Use screen to refer to the graphic portion of a monitor. Do not use display as an intransitive verb.

document

You can use document generically to refer to any kind of item within a folder that can be edited, but it’s 
clearer to restrict its use to Word, WordPad, and text documents. Use the specific term for “documents” 
in other programs.  For example, say “an Excel worksheet,” “a PowerPoint presentation.”

Use file for more general uses, such as file management or file structure.

double-click, double-clicking

Always hyphenate. Use instead of select and choose when referring to a mouse action. Do not use 
double‐click on.

download

As a transitive verb, use download to describe the process of intentionally transferring data, a file, or a 
program to the local computer, system, or device. Do not use download as an intransitive verb. If 
necessary for the context, use the passive is downloaded. Do not use downloaded to describe the process 
of opening, viewing, or switching to a webpage, even though some graphics or HTML files may be 
transferred to the user’s hard disk as a result.
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As a noun, use download to refer to data, a file, or a program that is available for downloading or that has 
been downloaded. Because download can be used as a noun or as a verb, be careful that the context and 
sentence structure make your meaning clear.

Design your webpage so that a user can review part of the page while your computer downloads the rest.

E 
edit

Because the term can be confused with the Edit menu, do not use to refer to making changes in a 
document unless you have no other choice. Use change or modify instead.

enable, enabled

Do not use to refer to things that a program makes easy or possible for the user if you can use you can 
instead. Enable can lead to weak sentences in which the most important fact is buried in an infinitive 
phrase.

With Microsoft Word 2010, you can save files in HTML format.

In content for a general audience, do not use enable with reference to commands or other program 
features. Use make available, turn on, or something similar, or rewrite the sentence.

To turn on change tracking, click the Tools menu, and then click Track Changes.

end user, end-user

In general, do not use. Use user, customer, or you instead. It is all right to use end user in content for 
software developers to distinguish the developer from the user of the developer’s program. It is all right 
to use end user in documentation for information technology professionals to distinguish the system 
administrator from the users of computers that the administrator is responsible for. Use end user as a 
noun, and use end‐user as an adjective.

ensure, insure, assure

In common English usage, ensure, insure, and assure are interchangeable in many situations. To provide 
consistency and to improve readability:

• Ensure = to make sure or guarantee

• Insure = to provide insurance

• Assure = to state positively or make confident

enter

Do not use as a synonym for type except to indicate that a user can interact with the UI by multiple 
methods, such as either typing text or clicking a selection from a list.
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In the Password box, type your password.
In the Font Size box, enter the font size you want to use.

exit

Use to refer to closing a program. Do not use to refer to closing a document or a window. Do not use to 
refer to switching from one program, document, or window to another.

F 
field

Do not use to refer to a text‐entry box. Refer to the box by its label. If you must use a descriptor, use box 
instead of field. Use field to refer to Word field codes, in a database context, and in other technically 
accurate contexts.

figure

Capitalize when identifying numbered art. In general reference to a figure, use lowercase.

Figure 5.2 compares the response times of the two versions.
As the figure shows, computer prices continue to decline.

file

Use generically to refer to documents and programs, as well as to units of storage or file management. 
However, be more specific if possible in referring to a type of file. For example, say “the Word 
document,” “your worksheet,” and “the WordPad program.”

F 
finalize

Do not use. Use finish or complete instead.

following

Use following to introduce art, a table, or, in some cases, a list.

The following table compares the different rates.
To install the program, do the following:

If following is the last word before what it introduces, follow it with a colon.

format, formatted, formatting
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Use format to refer to the overall layout or pattern of a document. Use formatting to refer to particulars 
of character formatting, paragraph formatting, and other types of formatting.

from

Use from to indicate a specific place or time as a starting point. Use from to indicate a menu from which a 
user chooses a command. For example, say “From the File menu, choose Open.” However, use on to 
indicate the starting place for clicking a command or option: “On the File menu, click Open.”

from, than

The adjective different is usually followed by from. Use from when the next element of the sentence is a 
noun or pronoun.

The result of the first calculation is different from the result of the second.

G 
gray, grayed

Do not use to refer to commands or options. Use unavailable or dimmed instead. If you need to describe 
the appearance of check boxes with portions of a larger selection that are already selected, use shaded, 
not grayed.

In the Effects group box, names of selected options may appear shaded.

H
he/she

Do not use. Use gender‐neutral pronouns.

Help

In general, do not use online Help. Just use Help by itself. However, online Help, definition Help, context‐
sensitive Help, and online Help files are correct when necessary to describe the Help system itself or to 
explain how to develop a Help system.

how-to, how to

Do not use how‐to as a noun. Hyphenate as an adjective. Whether how to is hyphenated or not, do not 
capitalize to in contexts that require title capitalization.

how‐to book
how‐to article

How to Format Your Hard Disk (Title capitalization)
Writing a How‐to Article (Title capitalization).
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I 
if, when, whether

To avoid ambiguity, use if to express a condition; use whether to express uncertainty, and use when for 
situations requiring preparation or to denote the passage of time. Do not use whether or not to express 
uncertainty.

in, into

In indicates within the limits, bounds, or area of or from the outside to a point within. Into generally 
implies moving to the inside or interior of. You run programs with, on, or under an operating system, not 
in one.

in order to

The phrase in order to may be verbose in general writing, and therefore it is better to just use to instead. 
However, in content that will be machine translated, using in order to avoids the ambiguity that the 
shorter form to frequently causes.

initiate

Do not use to refer to starting a program. Use start instead.

invalid, not valid

Both terms are fine to use, but they can be vague. Replace them with a more specific term whenever 
possible.

J
 justify, justified

Do not use as a synonym for aligned. Justified text is text that is both left‐aligned and right‐aligned. To 
describe alignment on one margin only, use left‐aligned or right‐aligned

L
later

Use instead of below in cross‐references. For example, say “later in this topic.” Do not use or later to 
refer to multiple versions of software. List each applicable version instead. The phrases or later and and 
later may imply that the functionality or feature discussed will be included or supported in all future 
releases. These phrases should not be used for legal reasons. You can use or earlier to refer to all versions 
of a product that precede a particular release if the statement is accurate for all preceding releases. For 
example, do not use “Windows 7 or earlier” unless the statement is accurate for Windows 1.0.
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less, fewer, under

Use less to refer to a mass amount, value, or degree. Use fewer to refer to a countable number of items. 
Do not use under to refer to a quantity or number.

let, lets

Do not use to refer to things that a program makes easy or possible for the user if you can use you can 
instead. log on, log off, logon, logoff. Use log on or log on to to refer to creating a user session on a 
computer or a network. Use log off or log off from to refer to ending a user session on a computer or a 
network. Use sign in and sign out to refer to creating and ending a user session on the Internet.

Do not use log in, login, log onto, log off of, log out, logout, sign off, or sign on unless these terms appear 
in the user interface. The verb form is two words, log on or log off. As a noun or adjective, use one word, 
no hyphen: logon or logoff. See also sign in, sign out, sign on, sign up, connect.

look at

Do not use to mean viewing something that you can view by clicking a command on a View menu. Also do 
not use look at to mean examine, analyze, or inspect.

look up

Use instead of see in cross‐references to online index entries from printed documentation. However, if 
you are using common source files for both printed and online documentation, use see.

lower

Do not use to indicate product version numbers. Use earlier.

M 
maximize, minimize

Can use both of these as verbs.

menu item

Do not use in content for a general audience. Use command instead.

more than vs. over

Use more than to refer to quantifiable figures and amounts. Use over to refer to a spatial relationship or 
position or in a comparison in which more is already used.
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N
navigate

Do not use to refer to the act of going from place to place on the World Wide Web or on an intranet. Use 
browse instead. To refer to the act of going directly to a webpage or website, whether by typing a URL in 
the Address bar of a browser or by clicking a hyperlink, use go to. Do not use see in this context.

need

Often confused with want. Be sure to use the term that is appropriate to the situation. Need connotes a 
requirement or obligation; want indicates that the user has a choice of actions.

O 
object

Do not use object as a synonym for item or thing unless you have no other choice. Try to be as specific as 
possible when you refer to an object because the term means different things in different contexts.

obsolete

Do not use as a verb. Use a phrase such as make obsolete instead.

of

Do not use of after another preposition in such phrases as “off of” or “outside of.” It is colloquial and can 
be confusing for the worldwide audience.

okay, OK

Use OK only to match the user interface. Otherwise, use okay. When referring to the OK button in 
procedures, do not use the and button.

on

Use on with these elements:

•  Menus (“the Open command is on the File menu”)

• Taskbar, toolbar, ruler, and desktop (“click Start on the taskbar”)

• Disks, in the sense of a program being on a disk (“the printer drivers on Disk 2”)

But: 

• Click OK

• Press Enter



Chapter 5: Terminology and usage

For Internal Use Only| HIGH TECC Editorial Style Guide© 2017 HIGH TECC Editorial Style Guide  32  

once

To avoid ambiguity, especially for the worldwide audience, do not use as a synonym for after.

onto, on to

Two words (on to) when referring to the action of connecting to a network, as in “log on to the network.” 
One word (onto) to indicate moving something to a position on top of something else, as in “drag the icon 
onto the desktop.”

option, option button

In general, refer to items in a dialog box only by their labels. If you must provide a descriptor, use option. 
Use the exact label text, including its capitalization, but do not capitalize the word option itself. You 
should generally refer only to the option that the button controls. If you must refer to the button to avoid 
ambiguity, use option button.

P 
page 

Refers to one of a collection of web documents that make up a website. Use page to refer to the page the 
user is on, that is, the particular document, or to a specific page such as the home page or start page. 
Also, use page instead of screen to refer to an individual screen within a wizard.

parameter

Technical term referring to a value given to a variable until an operation is completed. Do not use 
parameter to mean characteristic, element, limit, or boundary.

pop-up

Do not use as a noun. Also do not use as a verb to mean open or appear. It is all right to use pop‐up menu 
in a programming context to describe the menu that appears when the user right‐clicks an item. If you 
must use a term to describe this type of menu in content for a general audience, use shortcut menu. Pop‐
up window is all right to use in references to windows that pop up in context‐sensitive Help. Do not use 
pop‐up window as a synonym for dialog box.

preceding

Use preceding, previous, or earlier instead of above to mean earlier in a piece of content, but only if you 
cannot use a hyperlink, which is preferred.

preface
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Do not use Preface as the title of the introductory section of content. Use Introduction or a more 
descriptive title appropriate to the user, such as “Before you begin.”

press

Differentiate among the terms press, type, enter, and use. Use the following guidelines: Use press, not 
depress, hit, or strike when pressing a key on the keyboard.

Press Enter

Press Alt+S to save your document

Hit Enter to begin a new paragraph

Strike Alt+S to save your document

Use press and hold only if the program requires the user to do so because a delay is built into the periph‐

eral/interface interaction. Do not use press and hold when referring to a mouse button unless you are 

teaching beginning skills. Do not use press, hit, or strike as a synonym for click.

use, type

Use use when multiple platform or peripheral choices initiate the same action or actions within a pro‐

gram. An example is “Use the controls on your keyboard or controller to run through the obstacle course.” 

However, to teach beginning skills, be specific. For example, write “To run through the obstacle course, 

press the Spacebar on the keyboard or pull the right trigger on the Xbox controller.” Consider using a table 

to present instructions that have more alternatives than the two that are presented in this example.

Use use when press might be confusing, such as when referring to the arrow keys or function keys.

For example, with the statement “Press the arrow keys to move around the document,” press might make 

users think that they need to press all the keys simultaneously. Use type not enter, to direct a user to type 

information that the user cannot select from a list.

print, printout

As a verb, use print instead of print out. All right to use printout as the result of a print job, if necessary, 

but try to be more specific.

Q 
quit
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Do not use quit to refer to any of the following:

• A user closing a program: Use exit 

• A user closing a document or a window: Use close

• The action a program takes to close itself when it has encountered a problem and 

cannot continue: Use close instead (do not confuse with stop responding, which indi‐

cates that the program cannot close itself.)

• Ending a user session on a computer or on a network: Use log off 

• Ending a network connection: Use end instead.

 R 
refresh

Use refresh to refer to updating a webpage. Do not use to describe the action of an image being restored 

on the screen or data being updated. Use redraw or update instead. To refer to the Refresh command, use 

wording such as “To update the screen, click Refresh.”

remove

Do not use remove to mean delete. Remove is correct in technical contexts such as the following:

• To refer to taking an item off a list in a dialog box that has Add and Remove buttons

• To refer to taking a toolbar button off a toolbar, or hiding displayed data without 

deleting data, such as columns in Windows Explorer

• As a synonym for unload

• As a synonym for uninstall in a context that talks about adding instead of installing 

software or hardware

replace

Use replace only as an adjective or as a verb, not as a noun.

restore

Use as a verb instead of undelete to refer to restoring an item that was deleted. Use as a verb to describe 
the action of restoring an item or condition to its previous state, such as a window that was previously 
maximized or minimized. Do not use as an adjective or as a noun in content for a general audience except 
to follow the user interface. 

right-click

Use to describe clicking the secondary (usually the right) mouse button. In content for novice computer 
users, define the term if necessary.
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S 
save

Do not use as a noun.

select

Use select to refer to marking text, cells, and similar items that will be subject to a user action, such as 
copying text. Items so marked are referred to as the selection or the selected text, cells, items, and

so on. Use select to refer to adding a check mark to a check box or to selecting an item in a list box or a 

combo box list. Do not use select as a general term for selecting other options in a dialog box. Use click 

instead. Do not use highlight as a synonym for select. Selecting is a standard procedure, and highlight can 

often be confused with product features such as text highlighters that provide only visual emphasis. Do 

not use pick as a synonym.

set up, setup, Setup

Two words as a verb, one word as an adjective and as a noun. Capitalize Setup when it refers to the Setup 
program. Do not hyphenate. 

Verb: 

• Have everything unpacked before you set up your computer.

Adjective: 

• The setup time should be about 15 minutes.

Noun: 

• Your office setup should be ergonomically designed.

• Run Setup before you open other programs.

• Insert the Setup CD in the CD drive.

set vs. specify

It is worth avoiding words such as set and specify that make general reference to user actions. A better 
approach is to be specific about the action that the user should take.

should, must

An action that is recommended, but optional. Use must only to describe a user action that is required.

shut down, shutdown, Shut Down

Two words as a verb, one word as an adjective and as a noun. The Shut down command on the Start 
menu of Windows is two words.
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Shut down refers to the orderly closing of the operating system. Do not use shut down to refer to turning 
off the power to a computer. Do not use shut down as a synonym for close or exit.

sign in, sign out, sign on, sign up

Use sign in and sign out to refer to creating and ending a user session for an Internet account. You sign in 
to (not sign into) a MyMSN account, an Internet service provider account, or an XML web service. 

Use log on and log off to describe creating and ending a user session for a computer or intranet user 
account.

Use connect, make a connection, and similar phrases to refer to the act of physically attaching a 
computer to a network, whether intranet or Internet.

Use sign on only as part of the term single sign on (SSO). The user action is still signing in, even though the 
technology is called single sign on. Use sign off only informally to refer to getting approval. Otherwise, do 
not use sign on and sign off unless these terms appear in the user interface.

Use sign out to refer to closing a user session on the Internet.

Use sign up to refer to enrolling in a service.

Hyphenate these terms only when they are used as adjectives.

simply 

Do not use. Use just instead.

start page

Do not use to refer to the webpage that appears when the user starts the browser. Use home page

instead.

startup, start up

Do not use start up as a verb. Use start instead.

Do not use on startup and similar noun phrases in content for a general audience. You can use startup as 
an adjective in phrases such as startup disk and startup screen.

T
tech comm 

Short form for technical communication (field).

that, which
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That and which are often confused. Be sure to use the appropriate word. That introduces a restrictive 
clause, which is a clause that is essential for the sentence to make sense. A restrictive clause often 
defines the noun or phrase preceding it and is not separated from it by a comma.

then

Then is not a coordinate conjunction. Therefore then cannot correctly join two independent clauses. Use 
and then or then with a semicolon to connect two independent clauses. You can also begin a new 
sentence with Then or, in a procedure, make the then clause a separate step without using then.

On the File menu, click Save As, and then type the name of the file.
On the File menu, click Save As. Then type the name of the file in the Save as box.

U 
unavailable

Use unavailable instead of grayed or disabled to refer to unusable commands and options on the user

interface. Use dimmed only if you have to describe their appearance. Do not use the command name 
Undo as a noun to refer to undoing an action, especially in the plural. Write around instead, as in “to 
undo multiple actions” or “select the actions that you want to undo.” It is all right to say that a command 
undoes an action.

upper left, upper right

Hyphenate as adjectives. Use instead of top left and top right.

user name

Two words unless describing a label in the user interface. If the user interface uses the one‐word form 
username, use username to describe the interface element, but use user name in the rest of the text. In 
the Username box, type your user name.

W 
we

In general, do not use, except in the phrase we recommend.

webpage

Use webpage instead of Web page unless you must follow the user interface.

website

Use website instead of Web site unless you must follow the user interface. See also web
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where

Use to introduce a list, as in code or formulas, to define the meaning of elements such as variables or 
symbols.

Use the following formula to calculate the return, where:

r = rate of interest
n = number of months
p = principal

while

Use to refer only to something occurring in time. Do not use as a synonym for although or whereas.

Fill out your registration card while you wait for Setup to be completed.

who, that

Although there is no linguistic basis for not using that to refer to people, as in “the man that was 
walking,” it is considered more polite to use who instead of that in references to people. Use who, not 
that, to introduce clauses referring to users. Custom Setup is for experienced users who want to alter the 
standard Windows configuration.

want

Use instead of wish or desire. Do not confuse with need. Be sure to use the term that is appropriate to 
the situation. Need connotes a requirement or obligation; want indicates that the user has a choice of 
actions.
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Chapter 6: Glossary

A

acronym 12

An abbreviation formed from the initial letters of other words and pronounced as a word, e.g. NA‐
SA.

adjective 11

A word or phrase naming an attribute, added to or grammatically related to a noun to modify or 
describe it.

B

bullet 17

A vertical list set off by icons, usually a square, circle, or other shape.

C

callouts 19

A visual element (often a square or bubble) either on or adjacent to an illustration or image, with 
arrows pointing to specific parts to help users locate information or illustrate processes to them. 
See HIGH TECC’s visual guide for more information on callouts. 

Canadian spelling 9

The set of varieties of the English language native to Canada. Canadian English contains major el‐
ements of both British English and American English, as well as many uniquely Canadian charac‐
teristics (unique spelling).

captions 18

A title or brief explanation placed beneath a visual element (an image, illustration, chart, or table) 
in a document.
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G

grammar 5

The way in which words are put together to form proper sentences. 

H

HTML colour codes 19

HTML color codes are hexadecimal triplets representing the colors red, green, and blue 
(#RRGGBB). For example, in the color red, the color code is #FF0000, which is '255' red, '0' green, 
and '0' blue. These color codes can be used to change the color of the background, text, and ta‐
bles on a web page or in a document. See HIGH TECC’s visual guide for more information.

I

initialism 13

An abbreviation consisting of initial letters pronounced separately (e.g., CPU).

N

Non-standard 4

Terms that don’t conform in pronunciation, grammar, vocabulary, etc., to the usage characteris‐
tic of and considered acceptable by most educated native speakers; lacking in social prestige or 
regionally or socially limited in use.

noun 5

Any member of a class of words that can function as the main or only elements of subjects of 
verbs (A dog just barked), or of objects of verbs or prepositions (to send money from home), and 
that in English can take plural forms and possessive endings (Three of his buddies want to borrow 
John's laptop). Nouns are often described as referring to persons, places, things, states, or quali‐
ties, and the word noun is itself often used as an attributive modifier, as in noun compound

P

Parallelism 2

The use of successive verbal constructions that correspond in grammatical structure, meaning, 
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etc.

preference for lowercase 12

Also referred to as downstyle. Proper nouns are usually capitalized, but for some of the terms de‐
rived from or associated with proper nouns sparing use of capitals is preferred. President Obama, 
is capitalized, but the president is not. Sentence style capitalization is used in headings. HIGH 
TECC prefers this, referred to as ‘downstyle’. See The Chicago Manual of Style for more informa‐
tion.

pronoun 5

Used as replacements or substitutes for nouns and noun phrases, and that have very general ref‐
erence, as I, you, he, this, who, what. Pronouns are sometimes formally distinguished from 
nouns, as in English by the existence of special objective forms, as him for he or me for I, and by 
nonoccurrence with an article or adjective.

S

scannable 3

Refers to the ease with which a reader can scan the document. A scannable document is well or‐
gaized with headings, columns, or tables. It is easy for the reader to determine whether the con‐
tent will serve their needs, and if so, where in the document to locate the information they are 
seeking.

screen caps 19

Refers to screen captures, images of an interface used often in technical writing. Screenshots are 
most useful when used with callouts. See HIGH TECC’s visual guide for more information on 
screen captures and callouts.

searchability 3

Refers to how easily information can be located in a document.

T

terminology and usage 21

Frequently encountered terms, their meanings, and how to use them.
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U

usability 3

The degree to which something is able or fit to be used. In this guide, usability refers to how func‐
tional a document is, how useful and easy to use it is

V

verb 5

A word that in syntax conveys an action (bring, read, walk, run, learn), an occurrence (happen, 
become), or a state of being (be, exist, stand). In the usual description of English, the basic form, 
with or without the particle to, is the infinitive.

visual elements 17

Refers to visual elements added to a document such as tables, illustrations, charts, pictures (in‐
cluding screen captures with callouts), and lists. See HIGH TECC’s visual guide for more informa‐
tion.

voice 4

Voice is the author's style, the quality which conveys the author's attitude and meaning,


